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A.  Will you require JoVE to record video microscopy, such as filming a complex dissection or microinjection technique? (Y/N)  
B.   Does your protocol include detailed, step-by-step, descriptions of software usage? (Y/N) 

Yes 

If yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps.
C.  Which steps of your protocol will viewers benefit most from having filmed? 

Protocol sections 4.3, 4.4, 4.5, 4.7, 4.8, 5.3, 5.4, 5.5, 6.3, 7.1, 7.2

D.  What is the single most difficult aspect of this procedure and what do you do to ensure success? 

1. Practical difficulty: “Protocol section 5.4: Definition of a clear protocol that allows to synchronize the involved measurement systems”. This step is necessary when the involved data acquisition systems do not allow for direct synchronization due to the lack of a trigger or common channel.

2. Data analysis: “Protocol section 6.3: Identify the time in between any two nominally identical events of the load cycles”. Although this step can be straightforward, its results are the key to the accuracy of the remainder of the protocol. Therefore, this analysis is to be performed with care and the results should be checked closely before proceeding to the next step.

3. Simulation and analysis of the structural response: “Protocol section 7.1 and 7.2”. When everything is prepared, this can be a very short step but essential in interpreting and analyzing the results.

E.  Will the filming need to take place in multiple locations? (Y/N) Yes, two locations, i.e. in the laboratory and on a footbridge nearby (+/- 20 minutes by car).
1. Introduction 
A. Experimental Goal (read by voice talent at JoVE):
The overall goal of this procedure is to use the tracked motion of pedestrians to characterize human-induced loads and, subsequently, to verify the induced structural vibrations. (Intro)
B.  Required Interview Statements: (Said by you on camera. Don’t forget to smile!)  
1.1. Van Nimmen, Katrien: This method can help to answer key questions in the field of human-induced vibrations, such as the characterization of the individual walking behavior, the identification of the correlation among pedestrians in a crowd and the quantification of human-structure interaction phenomena. 
1.2. Van den Broeck, Peter: The main advantage of this technique is that it can be applied in situ and thus allows us to analyze real traffic conditions.
1.3. Katrien Van Nimmen: In-field observations are the only way to obtain detailed and accurate information on representative loading data. Therefore, they are essential for the further development and validation of load models for pedestrian excitation.
1.4. Peter Van den Broeck: Demonstrating the procedure will be Klaus Lievens, Xinxin Wei and Krumka Kasapova, three PhD students from our research group and Bram Gezels, and academic assistant.

1.1.1. Interview style: Author saying the above 

1.1.2. The named technician, post doc, student looks up from workbench or desk or microscope and acknowledges the camera.
E.  Ethics title card: (for human subjects or animal work, does not count toward word length total)

1.9. Procedures involving human subjects have been approved by the ethical committee of KU Leuven and each subject gave written informed consent prior to participation.

Protocol (read by voice talent at JoVE):
2. Preparing the Wireless Motion Trackers
2.1. Use wireless motion trackers to register the motion of pedestrians. [WID]

2.1.1. people behaving like pedestrians and wearing motion trackers in background, motion tracker software collecting data in the foreground, monitor in 1/3 of shot, people in other 2/3

2.2. To configure the sensors, use the MT Manager software to establish the wireless connection. Specify the desired “sample rate”, which should be least 60 Hz to capture human motion. [LM]

2.2.1. To be provided by authors: SCREEN CAPTURE of action(s) described above, TEXT: Tools > Wireless Configuration > Enable All Wireless Masters

File: 

“2.2.1. - 2.4.1. Preparing the Wireless Motion Trackers”
Start time:
0:00:00
End time:
0:00:16;10
2.3. Then, make slow movements with the motion trackers [2.3.1-MED] until they are connected and then continue by activating the measurement mode. [LM]

2.3.1. making slow movements with motion trackers to synch their connection
2.3.2. To be provided by authors: SCREEN CAPTURE of action(s) described above, TEXT: Wireless Configuration > Start measurement > OK

File: 

“2.2.1. - 2.4.1. Preparing the Wireless Motion Trackers”
Start time:
0:00:24;00
End time:
0:00:41;29
2.4. Next, display the inertial data of all the active motion trackers. 
2.4.1. To be provided by authors: SCREEN CAPTURE of action(s) described above, TEXT: View > Display > Inertial Data

File: 

“2.2.1. - 2.4.1. Preparing the Wireless Motion Trackers”
Start time:
0:00:42;10
End time:
0:01:07;00
2.5. Now, attach a motion tracker as closely as possible to each participant’s center of mass. [WID] Robustly fasten the motion tracker onto the participant [2.7.1-MED] so it is snug and secure. [2.7.2-CU]
2.7.1. centering tracker on participant
2.7.2. Fastening tracker to participant

2.7.3. once fastened, budge the tracker to show how tightly attached it should be attached

2.6. Now, data can be recorded as required. [2.1.1]

3. Preparing the Force Plate

3.1. When making measurements in the laboratory, [3.1.1-MED] the motion of the human subject can be tracked simultaneously with ground reaction forces [3.1.2-LM] measured with a force plate. [3.1.3-MED]

3.1.1. establish one talent tracking data on computer, screen showing what is about to be shown in next screen capture

3.1.2. To be provided by authors: SCREEN CAPTURE of tracking motion at the same time as ground reaction forces, talent might be jumping on the force plate so the viewers can try to guess what's occurring

File: 

“3.1.2. and 4.4.1. Preparing the Force Plate and Conducting an Experiment in the Lab”
Start time:
0:01:52;08
End time:
0:02:20;29

3.1.3. talent jumping on the force plate (the reveal)

3.2. First, use the accompanying software to configure the force plate and acquisition settings.

3.2.1. To be provided by authors: SCREEN CAPTURE of action(s) described above, TEXT: NDI Open Capture > Data > Device Settings > Settings

File: 

“3.2.1. - 3.5.1. Preparing the Force Plate”
Start time:
0:00:00;00
End time:
0:00:06;22
3.3. Select a “gain” and “sample rate” in accordance with the desired accuracy and the involved loading type. For human-induced loads, set the gain for a maximum force of 4879 Newtons and set the sample rate to 200 Hz.

3.3.1. To be provided by authors: SCREEN CAPTURE of action(s) described above

File: 

“3.2.1. - 3.5.1. Preparing the Force Plate”
Start time:
0:00:06;22
End time:
0:00:23;28
3.4. Always start and end a measurement with an empty force plate. [MED]


3.4.1. talent gets onto the force plate and then off of the force plate – focus on plate
3.5. Use the Tare function or the “Automatic Offset Correction” to reset the force when the plate is empty.  Once tared, data can be recorded as required.  
3.5.1. To be provided by authors: SCREEN CAPTURE of action(s) described above, TEXT: NDI Open Capture > Data > Device Settings > Settings > Tare

File: 

“3.2.1. - 3.5.1. Preparing the Force Plate”
Start time:
0:00:23;28
End time:
0:00:35;15
4. Preparing the structural response recorders
4.1. For measurements performed on site, structural vibrations can be measured at relevant locations, such as at midspan of a footbridge. [LM]

3.6.1. See corresponding video fragment Séan Glavey.
4.2. To do this, use displacement, velocity or acceleration sensing recorders. [CU]

3.7.1. Unpacking a GeoSIG recorder
We don’t want to have “GeoSIG” in the narrative, however, we can certainly show their logo when demonstrating use of their device. (ok! Logo does not need to be shown)
4.3. Configure the recorders according to the manufacturer’s instructions. [CU]

3.8.1. configuring a recorder, following instructions from manufacturer, TEXT: See the text protocol for further details.

4.4. After placing the recorders at the desired locations, [3.9.1-WID] level them in agreement with the global reference frame. [3.9.2-MED]

3.9.1. placing a GeoSIG somewhere in lab that may make sense to place it on

3.9.2. performing the “leveling” process of the recorders
5. Conducting an Experiment in the Lab
5.1. In the lab, after setting up motion trackers and the force plate, start the data recording. [4.1.1-WID] Then, ask the participant to step onto the force plate and stand still [4.1.2-WID] for at least 30 seconds.  Thus, weigh the participant. [4.1.3-LM]

4.1.1. attaching motion sensor to participant and then going to computer and starting the recording

4.1.2. gesturing to participant to stand on the force plate, participant does so and stands still

4.1.3. To be provided by authors: SCREEN CAPTURE showing the weight on the force place stabilizing

File: 

“4.1.3. Conducting an experiment in the Lab - showing the weight on the force plate stabalizing”
Start time:
0:00:00;00
End time:
0:00:20;01
5.2. Next, start a metronome to dictate the fundamental forcing frequency. [MED]

4.2.1. starting a metronome at a reasonable speed, record audio, show blinking light on metronome

5.3. Then, ask the participant to move at the pace of the metronome signal, such as by walking, jumping or bobbing. [WID]

4.3.1. talent starts skipping/bobbing/moving on force plate at the speed of the metronome - record audio, show blinking light on metronome if possible

5.4. Record this activity for a sufficient number of cycles.  Sixty cycles are recommended.
4.4.1. To be provided by authors: SCREEN CAPTURE of collecting data

File: 

“3.1.2. and 4.4.1. Preparing the Force Plate and Conducting an Experiment in the Lab”
Start time:
0:01:43;09
End time:
0:02:27;12
5.5. When the cycles are complete, ask the participant to get off the plate.  [WID]

4.5.1. talent finishes movements and gets off the plate
6. Conducting an Experiment in the field
6.1. For experiments conducted on site, on a civil structure of interest, [4.6.1-WID] setup the motion trackers and a network of sensors that will register the structural vibrations.  [4.6.2-MED]

4.6.1. pan over setting, talent setting up sensors on footbridge

4.6.2. detail of placing a sensor to test for structural vibration on footbridge

6.2. In an outdoor setting, a megaphone can be used to amplify the metronome signal. [MED]

4.7.1. starting metronome and setting it up next to megaphone, then turning on the megaphone

6.3. On site, repeat the test at least three times, preferably four times [4.8.1-WID], to check the repeatability of the experiment. [4.8.2-WID]

4.8.1. participants performing a test on footbridge side angle on bridge – record the sound of the megaphone's amplified metronome signal, participants should be in synch with this sound
4.8.2. participants performing a test on footbridge view of walking area on bridge – record the sound of the megaphone's amplified metronome signal, participants should be in synch with this sound (different angle, 
6.4. In any setting when multiple acquisition systems are used and no trigger [4.9.1-WID] or common channel is available, synchronize the devices using a single event [4.9.2-MED] that each system can register, such as a strong impact. [4.9.3-LM]

4.9.1. setting up a device to create an impact event that'll register on all the devices

4.9.2. performing the impact event

4.9.3. to be provided by authors: SCREEN CAPTURE showing the impact event reading from different devices data sets

File: 

“4.9.3. Conducting an experiment in the field - showing the impact event reading from different devices data sets”
Start time:
0:00:28;23
End time:
0:02:39;19
6.5. Add synchronizing events to the beginning and end of each test. Based on these events, the data of the different systems can be synchronized offline. [WID]

4.10.1. performing impact event again, any moving participants should be finishing their activity

6.6. Peter Van den Broeck: When performing dynamic measurements with more than one type of sensor, synchronization of the data is essential. Whenever possible, preference is given to the use of a single data acquisition system or for the systems to record a common signal. [WID]
4.11.1. interview with Peter, in either the lab or in the field

7. Analyzing the Data
7.1. Begin by identifying the time between the nominally identical events of the load cycles. For the reference lab experiments, perform this step on both the pedestrian motion data and the force plate data. 

7.1.1. SCREEN CAPTURE, working out load cycle from motion data and plate data TEXT: pedivib > lc_timing > Load

File: 

“7.1.1. - 7.6.1. Analyzing the data - lc_timing”
Start time:
0:00:00;00
End time:
0:00:14;07
7.2. After loading the data, specify the sampling rate and estimate the average loading frequency.  Also, specify the relevant time window, if needed.

7.2.1. SCREEN CAPURE, TEXT: pedivib > lc_timing > Apply

File: 

“7.1.1. - 7.6.1. Analyzing the data - lc_timing”
Start time:
0:00:14;07
End time:
0:00:28;28

7.3. Katrien Van Nimmen: The most critical step of the procedure lies in the identification of the onset of each load cycle from the tracked pedestrian motion. It is this timing information that allows us to compute the time-variant pacing rate of the pedestrian.

5.5.1. Interview with Katrien at the computer 
7.4. For the analysis of the experiments in the lab, exclude the first and last five cycles from the analysis and work with the remaining fifty. Be sure to visually check the timing information before saving the data.
7.4.1. SCREEN CAPTURE, TEXT: pedivib > lc_timing > Save

File: 

“7.1.1. - 7.6.1. Analyzing the data - lc_timing”
Start time:
0:00:28;28
End time:
0:00:59;29
7.5. Now, compute the average fundamental loading frequency as the inverse of the average time in between the subsequent load cycles.

7.5.1. SCREEN CAPTURE

File: 

“7.1.1. - 7.6.1. Analyzing the data - lc_timing”
Start time:
0:00:59;29
End time:
0:01:07;00
7.6. When multiple pedestrians are involved, the identified timing information can be applied to analyze their correlation.

7.6.1. SCREEN CAPTURE, multiple sensor data

File: 

“7.1.1. - 7.6.1. Analyzing the data - lc_timing”
Start time:
0:01:07;00
End time:
0:01:25;08
7.7. For the analysis of the experiments on site, the next step is to use the identified timing information to simulate the induced structural response. Firstly, define the modal parameters of the test structure. These include the Natural frequencies, modal damping ratios, and the mass-normalized modal displacements.

7.7.1. SCREEN CAPTURE, TEXT: pedivib > Structural parameters > New

File: 

“7.7.1. - 7.8.1. Analysing the data - pedivib - structure”
Start time:
0:00:00;00
End time:
0:01:01;27
7.8. Be sure to visually check the modal input information before proceeding.

7.8.1. SCREEN CAPTURE

File: 

“7.7.1. - 7.8.1. Analysing the data - pedivib - structure”
Start time:
0:01:01;10
End time:
0:01:17;02
7.9. Secondly, define the characteristics of the pedestrians and their induced loads: these include the load type, weight, walking path or location, average pacing rate and timing of the load cycles. 
7.9.1. SCREEN CAPTURE, TEXT: pedivib > Single pedestrian > Characterise > New

File: 

“7.9.1. - 7.11.1. - Analyzing the data - pedivib - pedestrian”
Start time:
0:00:00;00
End time:
0:01:15;15
7.10. Specify the solution parameters, such as the output locations, as well as the Time parameters.  Then, run and save the simulated structural response for the involved participants.

7.10.1. SCREEN CAPTURE, TEXT: pedivib > Single pedestrian > Structural response > New

File: 

“7.9.1. - 7.11.1. - Analyzing the data - pedivib - pedestrian”
Start time:
0:01:15;15
End time:
0:01:46;21
7.11. As before, visually check the results before proceeding.

7.11.1. SCREEN CAPTURE

File: 

“7.9.1. - 7.11.1. - Analyzing the data - pedivib - pedestrian”
Start time:
0:01:50;08
End time:
0:02:09;09
7.12. Thirdly, compute the total structural response through superposition of the individual responses by summing the corresponding vectors.  

7.12.1. SCREEN CAPTURE

File: 

“7.12.1. - 7.13.1. Analyzing the data - pedivib - comparison”
Start time:
0:00:00;00
End time:
0:00:16;24
7.13. Then, compare the result with the measured structural response with a graphical representation of the data. 
7.13.1. SCREEN CAPTURE

File: 

“7.12.1. - 7.13.1. Analyzing the data - pedivib - comparison”
Start time:
0:00:16;24
End time:
0:00:41;28
8. Results: A Single Pedestrian in the Lab and Six Pedestrians on a Footbridge 

8.1. From a single pedestrian tested in the lab, the onset of each load cycle was identified. This data is used to simulate the walking forces, shown in grey, and compared to the measured forces, shown in black.  A good approximation of real walking forces was obtained.

8.1.1. 811_figure1_figure showing the identified onset and the comparison between measured and simulated forces
8.2. Similarly, the walking behavior of six pedestrians on a footbridge was analyzed. Again, the onset of each load cycle was identified from the tracked pedestrian motion. 
8.2.1. 821_figure1_figure showing the identified timing of the load cycles of 6 pedestrians
8.3. This load cycle information was then used to simulate the pedestrian-induced forces. After about 16 seconds, the pedestrians were walking in step, while after 50 seconds, a significant loss of synchronization was observed.
8.3.1. 831_figure1_extending previous figure with corresponding calculated synchronization rate

8.4. By comparing the timing of the load cycles among the pedestrians, the synchronization rate was found to decrease to 60% after about 50 seconds. 
8.4.1. 841_figure1_figure showing both the synch rate and the simulated forces
8.5. The structural response was then simulated.  When the pacing rate of the pedestrians was assumed to be constant and identical to the metronome signal, shown in grey, the result significantly overestimated the measurements, shown in black. When the simulation accounted for the identified time-variant pacing rate, shown in blue, it was clearly closer to the measured response.

8.5.1. 851_figure1_figure showing both the synch rate and the structural response
9. Conclusion (said by authors on camera)
9.1. Peter Van den Broeck: This procedure can be applied to analyze the natural walking behavior of pedestrians. In this way, essential input is provided for the development of suitable models for the correlation among pedestrians in real traffic conditions. 

9.2. Katrien Van Nimmen: In addition, the comparison between the measured and the simulated structural response allows us to verify and calibrate the models used to simulate the human-induced loads. By doing so, also the impact of human-structure interaction phenomena, such as added damping, can be investigated. 

Provided Media

Authors, Please list all images, movie files, or 3-D rendered animations that can be included in the video per editor’s request.  The step in the script/video where these images will be inserted should be specified.   For example:

6.2 –  0123_PIname_Figure1.tif -  dual color imaging of tumor angiogenesis at 40X 

6.2 –  0123_PIname_Figure2.tif -  dual color imaging of tumor angiogenesis at 100X

Formats:  For static images we prefer .tiff, .eps, Illustrator, Powerpoint or Photoshop files at dimensions of at least 720X480 pixels and 300 dpi.  The higher resolution, the better.  Likewise any exported movie files should have at minimum these dimensions and be rendered to .mov, .mp4, or .avi files.  

Insert your media filenames here.

General Preparation
It’s critical for a smooth and organized shoot that all reagents are accounted for, in advance.   

Any overnight or long incubation steps should be recognized and specimens/samples be prepared in advance so that prior steps can be recorded and shooting can continue with pre-prepared specimens/samples.  

All tubes/flasks should be pre-labeled neatly before we arrive.  

Ex. Luciferase assay done in 96 well plates should be labeled with negative/positive control wells and experimental samples are labeled accordingly.

You will receive more detailed preparation instructions are included in the email accompanying the finalized script.
 2016, Journal of Visualized Experiments


